
 
 

labMANUAL    

 

 

 

 

 

 

Software User Manual 

 

labZY-MCA  

Versions 8.50 to 8.59 

Rev. 1a 

 

 

 

 

 

 

 



 
©2019 labZY  labZY-MCA  User Manual  Rev. 1a www.labzy.com         2  
 

 

Contents 
 

Overview and Installation ................................................................................................ 4 

Software Overview ....................................................................................................... 4 

Unique Features .......................................................................................................... 4 

Installation .................................................................................................................... 5 

Executing labZY-MCA .................................................................................................. 9 

Basic Components .......................................................................................................... 11 

Menu Components ..................................................................................................... 11 

File .......................................................................................................................... 11 

Edit ......................................................................................................................... 14 

View ........................................................................................................................ 16 

Hardware ................................................................................................................ 18 

Spectrum ................................................................................................................ 22 

Utility ....................................................................................................................... 25 

Help ........................................................................................................................ 28 

Docking Windows ...................................................................................................... 29 

Spectrum Window ................................................................................................... 29 

DPP Window........................................................................................................... 30 

SIGNALS Window .................................................................................................. 36 

PHA Window........................................................................................................... 43 

Acquisition Window ................................................................................................. 43 

Calibration Window ................................................................................................. 49 

Spectrum Info Window ............................................................................................ 50 

Trace Viewer Window ............................................................................................. 51 

Debug Window ....................................................................................................... 56 

Events Window ....................................................................................................... 56 

Device Bars ................................................................................................................ 57 



 
©2019 labZY  labZY-MCA  User Manual  Rev. 1a www.labzy.com         3  
 

Standard ................................................................................................................. 57 

Hardware Control .................................................................................................... 57 

View Control ........................................................................................................... 58 

Mouse and Keyboard Functions ................................................................................ 58 

Selecting and Moving the Cursor ............................................................................ 58 

Marking/Unmarking ROI ......................................................................................... 59 

Controlling the Spectrum Display ............................................................................ 60 

Appendix A: labZY File Format (.lzs) ............................................................................. 63 

Appendix B: Setting BDC ............................................................................................... 65 

 

 

 

 

  



 
©2019 labZY  labZY-MCA  User Manual  Rev. 1a www.labzy.com         4  
 

Overview and Installation 
 

Software Overview 

 

The labZY-MCA software application is compatible with the following labZY radiation 

spectroscopy devices (henceforth referred to as the labZY devices): the nanoMCA(-SP), 

the nanoMCA-II(-SP), the nanoXRS, and the nanoDPP. The labZY-MCA application 

provides an interface to these devices, with the ability to set device operating 

parameters, verify correct device operation, and acquire spectral data that can be 

displayed and analyzed using basic spectroscopy tools. Furthermore, acquired spectra 

can be stored as files for subsequent viewing and analysis.  

The labZY-MCA application is not an analytical software. The labZY devices cover a 

variety of detector systems; each system requires specific analytical procedures that are 

part of specialized software applications and routines. While the labZY-MCA application 

provides basic tools for spectral analysis, it is recommended that either open-source or 

commercial software packages be used for a detailed analytical assessment of the 

acquired spectra. 

 

Unique Features 
 

The labZY-MCA application offers unique features that support the advanced 

functionality of the labZY hardware, including setting the Spectrum Hard Size and 

Spectrum Soft Size functionalities. All spectra are recorded by the hardware at the finest 

channel resolution possible (the largest number of channels per spectrum). The number 

of channels recorded by the hardware is called the Spectrum Hard Size. The hard size 

spectrum is the only spectrum that is transferred from the hardware to the software. The 

software stores the transferred hard size spectrum in its memory and files. The labZY-

MCA application allows the hard size spectrum to be displayed and exported into a file 

as a Spectrum Soft Size, or a spectrum that has fewer channels than the hard size 

spectrum. The transformation from hard size to soft size is distortion free and does not 

destroy the original hard size spectrum. The labZY-MCA application allows for instant 

exploration of different spectrum sizes with a single spectrum recording. This is a 

significant improvement in comparison to traditional MCAs, which offer hardware 

spectrum size selection and require spectrum recordings for each size in order to 

determine the optimal spectrum size. Because the Spectrum Hard Size spectra are 
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always stored as labZY spectrum files, it is recommended that all spectra are first stored 

as labZY spectrum files and then exported into soft size files. The soft size spectra can 

be exported into text files which can be used for processing with other spectrum 

analyzing applications. 

The labZY spectroscopic products have a built-in Digital Pulser. The Digital Pulser acts 

like the Analog Pulser** except it is noise free and does not interfere with the detector 

signals. The labZY-MCA application can turn the pulser on or off and obtain pulser peak 

information to estimate the intrinsic resolution of the system. The Digital Pulser can also 

check the base line, pole-zero adjustment, pulse tailing, presence of non-random signal 

pick-up, etc. It is not designed to be used for dead-time estimation. For more details, 

refer to the labPAPER “Digital Pulser” at www.labzy.com.. 

The labZY-MCA application, in conjunction with the labZY hardware, reports the True 

Incoming Counting Rate (ICR), correcting for the pile-up losses in the fast and/or slow 

channels of the spectrometer. labZY’s approach has better ICR estimation than the 

traditional method of ICR reporting, which is based on the counting rate of the fast 

discriminator and is always subject to pile-up counting loses. 

The labZY-MCA application provides enhanced peak information by calculating not only 

the full width at half maximum (FWHM) of the peaks, but by also reporting the peak 

Resolution In Percentage. This feature is valuable for assessing the resolution of 

scintillation detectors, which is normally reported as a percentage. 

 

Installation 
Supported Operating Systems: 

Windows 10 
Windows 8 
Windows 7 
Windows Vista 
Windows XP 

 
The labZY-MCA software can be installed either from the supplied flash drive when 

purchasing the device or by downloading the installation file on www.labzy.com. To 

install the software from the flash drive, insert the flash drive into the computer’s USB 

port. In the labZY-MCA directory, execute setup.exe. To install the software from 

www.labzy.com, first download install_labzy-mca_VERSION.zip and unzip or open the 

downloaded file. The downloaded version of the software should correspond to the 

software version described in this manual. Execute setup.exe and follow the instructions 

of the software installer as outlined below.  
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Step 1 

 

Figure 1.1. Welcome page of labZY-MCA Setup Wizard window. 

Press “Next.” 

Step 2 

 

Figure 1.2 Confirm Installation page of labZY-MCA Setup Wizard window. 

Press “Next.” 
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Step 3 

 

Figure 1.3. Wait for the installation to complete 

Step 4 

 

Figure 1.4. Installation Complete page of labZY-MCA Setup Wizard window. 

Press “Close.” 
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After the installation is complete, a shortcut to labZY-MCA application will be placed on 

the desktop. 

 

Figure 1.5. labZY-MCA application icon. 

A group called labZY will be created in "All Programs," under the start menu. The labZY 

folder contains shortcuts to the labZY-MCA software and the utility to Uninstall labZY-

MCA. The labZY group is shown below. 

 

Figure 1.6. labZY group in Windows 7 and Windows XP. 

 

 

Figure 1.7. labZY group in Windows 10. 

 

To uninstall the labZY-MCA software, execute the Uninstall labZY-MCA shortcut. If 

you need to reinstall or upgrade the labZY-MCA software, you must first run the 

Uninstall labZY-MCA utility.  
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Executing labZY-MCA 
 

The labZY-MCA software application can be started by executing one of the shortcuts to 

it. The default layout of the application may differ slightly depending on the Windows 

version and the computer screen resolution. It is recommended that the screen 

resolution is greater than 1440 x 900 pixels. Depending on the Windows security 

settings, the following messages may appear  

 

 

 

Figure 1.8. User Account Control - Verified Publisher: LABZY, LLC message. 

Press “Yes.” 

The labZY-MCA software will open a window displaying the default layout of the 

application (Fig. 1.9). 

The labZY-MCA application can be terminated by executing the Exit command of the 

File menu. Alternatively, the “X” button in the upper right corner may be used to 

terminate the application. When labzy-MCA terminates, its current visual state is stored 

and will be restored at the next run. No other information is preserved upon exiting the 

application. 
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Figure 1.9. labZY-MCA default layout. 
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Basic Components  
 

Menu Components 
 

File 

 

Figure 2.1.1. File menu. 

The File menu can Open Spectrum files and Save Spectrum As… a labZY file format, 

with default extension .lzs. Additionally, it can Export Spectra to other file formats. The 

labZY file format (.lzs) and the CSV file spectrum recording are described in Appendix 

A.  

When saving and exporting a spectrum, a prompt is displayed to enter a Spectrum Tag.  

 

 
 

Figure 2.1.2. Spectrum Tag. 

 

This tag can be a brief description of the spectrum or any other information that can be 

used as a future reference when the file is opened and/or processed. The tag limit is 80 

characters. The tag is always saved in labZY formatted files and CSV exported files. 

Using commas in the CSV file tag will cause the comma-separated text fields to be 
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treated separately by software applications such as Microsoft Excel. The spectrum tag 

will not be recorded if the spectra are exported to file formats which do not support tags.  

IMPORTANT: Prior to saving a spectrum seen in the spectrum buffer, spectrum 

acquisition must be stopped for at least 3 seconds. This is because the spectrum buffer 

represents an active hardware spectrum acquisition.  

Saving spectra using the labZY file format also saves all of the hardware settings, along 

with the volatile data at the time of saving. To save the hardware settings, it is 

important that the Buffer tab of the Spectrum Window is selected and the labZY-MCA 

application is connected to a labZY device. The ROI and calibration data are also stored 

in labZY spectrum files.  

The Open Spectrum command can only open spectra saved in a labZY file format, with 

extension .lzs. When a spectrum is opened, it is loaded into a separate memory 

displayed under the File tab of the Spectrum Window. When the file tab is selected, the 

title bar of the Spectrum Window displays the file path and file tag of the spectrum being 

viewed. 

Furthermore, when a spectrum is opened, the hardware settings are recalled and stored 

in a virtual hardware. It is possible to transfer the virtual hardware settings to the 

physical hardware using the Copy Registers → File to Buffer command of the Hardware 

menu, which will load the previously stored hardware configuration into the physical 

hardware. While the File tab is selected for a loaded spectrum, all hardware-related 

menu commands, the hardware-related windows and the toolbar buttons are disabled, 

as they are separate controls from the Buffer hardware controls. These separate 

controls relate only to the virtual hardware and not to the physical hardware connected 

to the labZY-MCA application. 

The calibration and ROI data are also recalled when a spectrum is opened. These data 

are also stored separately in memory associated with the File tab of the Spectrum 

Window. The calibration and ROI data can be exchanged between File and Buffer data 

storages using the appropriate Copy Calibration and Copy ROI commands in the 

Spectrum menu. 

Additionally, the spectrum loaded by the Open Spectrum command and displayed in the 

File tab can be further analyzed by marking ROIs and/or by using the functions 

available in the Calibration Window. Spectrum information of the File tab is separate 

from the spectrum information of the Buffer tab. The loaded spectrum in the File tab 

along with any calibration and/or ROI changes can be saved or exported under a 

different name. 
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Figure 2.1.3. labZY-MCA sample spectrum in default layout. 

The Export Spectrum To…. command has a selection of different file formats. The 

spectrum can be exported either as a Hard Size Spectrum or as a Spectrum with the 

currently selected Soft Size. These software releases allow the spectra to be exported 

in a CSV file format or Ortec CHN format. Note that exported spectra not in .lxy format 

may not be opened by the labZY-MCA application.  

 

Figure 2.1.4. File menu → Export Spectrum To… → CSV File options. 
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The Export Trace Viewer…. command is used to export the numerical data 

corresponding to the currently displayed waveforms by the Trace Viewer. The RAW 

Traces are the digital signal data as transferred from the hardware. The digital signal in 

the Normalized Traces has been amplitude-corrected for the digital shaper gain. It is 

recommended to export traces as Normalized Traces. The logic signals are exported as 

a sequence of ones and zeros. The trace data is in CSV or TXT file formats suitable to 

be opened by Microsoft Excel or other spreadsheet applications. 

 

Figure 2.1.5. File menu → Export Trace Viewer… options. 

Edit 

 

 

Figure 2.1.6. Edit menu → Copy Spectrum options. 

 

The Edit menu has commands that allow copying of the docking windows’ visual 

content to the clipboard. Note that the copied images are exact copies of the windows 

and their content as shown on the display. If other windows block the visual content of 

the windows being copied, the blocking overlay will be captured upon executing the 

copy commands. The Copy Spectrum command has two selectable options in a 

submenu. The Spectrum option will copy only the spectrum area of the Spectrum 
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Window. The Window option will capture the entire Spectrum Window including its 

border and caption, and can be executed using the keyboard shortcut Ctrl+C.  

 

a) b)  

Figure 2.1.7. Clipboard Images: a) Copy Spectrum → Spectrum;  

b) Copy Spectrum → Window (Ctrl+C). 

 

 

 

Figure 2.1.8. Edit menu → Copy Trace View options. 

 

The Copy Trace View option will copy the visual content of the Trace Viewer to the 

clipboard. This command has two options. The Traces option will copy only the trace 

area of the Trace Viewer. The Viewer option will capture the entire Trace Viewer 

window including the window border and all Trace Viewer controls as displayed on the 

screen.  
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         a)       b) 

Figure 2.1.9. Clipboard Images: a) Copy Trace View → Traces;  

b) Copy Trace View → Viewer. 

 

View 

 

 

Figure 2.1.10. View menu. 

The View menu controls the appearance of the application. The Toolbars and Windows 

command offers a submenu to turn the Toolbars (Standard, Hardware Control, View 

Control), and the Docking Windows ON or OFF. A check mark next to a window or a 

toolbar indicates that the corresponding window or toolbar is turned ON. By selecting 

the Status Bar command, the Status Bar can be turned ON or OFF. 
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Figure 2.1.11. View menu → Toolbars and Windows options. 

 

The Application Look command has submenus with different application styles. Some 

Windows versions may not support or correctly display some of the styles. The default 

style is Black Style. 

 

Figure 2.1.12. View menu → Application Look → Office 2007 options. 
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Restore Layout restores the size, position, and other view attributes (excluding the 

Application Look) from when the application was last opened. This command is useful if 

the docking windows become hidden or scrambled. Note that at exit, labZY-MCA stores 

the current appearance of the application, which is automatically reloaded at the next 

start. This reloaded appearance will be restored if the Restore Layout command is 

executed. 

Default Layout restores the size, position, and other view attributes to the default state 

at the time of software installation. 

Hardware 

 

 

Figure 2.1.13. Hardware menu. 

The Hardware menu has various controls related to the labZY hardware. The Platform 

command provides a selection for how the computer identifies the connected hardware. 

All labZY devices have built-in identification features as part of labZY’s FPGA designs. 

Therefore, the Auto option will automatically identify the hardware. However, in the case 

that the automatic identification fails or the FPGA design does not support automatic 

identification, the type of the hardware platform may be chosen manually. It is 

recommended not to select platforms manually but rather to use the Auto setting. 
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Figure 2.1.14. Hardware menu → Platform options. 

The Port command allows the user to choose the communication port of the connected 

hardware. This command may also be used to identify the port of a specific connected 

labZY device. The port identification can only be performed for USB ports. To identify 

the port, start the labZY-MCA application and disconnect the labZY device of interest 

from the computer. Execute the Port command from the menu. A port dialog will open. 

 

Figure 2.1.15. Available ports (Hardware > Port). 

Take note of the drop-down list of available ports. Close the port selection. Connect the 

hardware to an available USB port. Wait until the USB driver installs. Re-open the 

dropdown list of ports. The new USB port should appear in the drop-down list when 

compared with the port list before the hardware connection. If the port list does not 

change, then either the USB driver was not installed correctly, or the hardware failed to 

connect to the USB port. If the port of the labZY device is identified, select the relevant 

port and close the dialog by pressing “OK.”  

Once the port has been identified and selected, the labZY-MCA application can 

establish connection to the hardware by executing the Connect command. The Connect 

command is disabled during an active connection. 
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The AutoConnect command does not require port selection and will automatically 

search for labZY devices and connect to them. It is strongly recommended that the 

AutoConnect command is used to connect to labZY devices.  

  

Figure 2.1.16. labZY Port Finder window during a search. 

If more than one device is found, the AutoConnect dialog will present a drop list to 

choose a port. The found devices in the drop list will be identified by their serial number 

and the port they are connected to. Select the port of the device of interest and press 

the “OK” button.  

If the AutoConnect fails to find a device, it may be executed a couple more times. If no 

ports are found after a few attempts, a hardware connection and/or driver installation 

troubleshooting must be performed. 

The Disconnect command will disconnect the labZY-MCA application from the 

hardware. The Disconnect command is disabled if no hardware is connected. 

The Copy Registers command is used to transfer hardware settings from spectrum 

Buffer to File and vice versa. It is strongly recommended that the users exercise 

extreme caution as the action caused by this command is not reversible. It is 

recommended to save the hardware settings before executing the Copy Registers 

command. To save the hardware settings, use Save Spectrum As… to store a Buffer 

spectrum of a connected labZY device. The spectrum can be blank; the labZY spectrum 

file record always includes the hardware settings.  

Every saved spectrum has hardware settings stored in it. These settings can be 

transferred to the hardware by executing the Copy Registers → File to Buffer command. 

To transfer settings to a labZY device, first establish a connection between the device 

and the labZY-MCA software. Next, open a file containing the hardware settings to be 

uploaded to the hardware. Execute the Copy Registers → File to Buffer command, 

accepting the displayed warning. This should complete the transfer. Note that only 
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hardware-related settings can be transferred. For example, the Soft Size setting will not 

be transferred as it is a pure software feature.  

 

Figure 2.1.17. Hardware menu → Copy Registers options. 

The Copy Registers → Buffer to File command can be used for a temporary storage of 

hardware settings while the labZY-MCA application is running. If needed, these 

temporarily stored settings can be restored to the hardware using the Copy Registers → 

File to Buffer command. Although it is possible to modify the hardware settings of saved 

spectra, such practice should be avoided as the original hardware settings saved with 

the corresponding spectrum will be permanently lost.  

When a labZY device is connected, the About Hardware option will be enabled. This 

command opens an information window displaying hardware specific information such 

as the serial number, the expected time constant of the input signals, the version of the 

FPGA design, and other hardware-related details.  

 

About hardware 
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Spectrum 

 

Figure 2.1.18. Spectrum menu. 

 

The Spectrum menu controls various aspects associated with the acquired spectra or 

the spectra opened from files. The Soft Size command opens a submenu with choices 

of the spectrum soft size. A check mark next to a soft size indicates the current 

selection. The soft size is controlled independently for the Buffer and the File spectra. 

 

Figure 2.1.19. Spectrum menu → Soft Size options. 

The Soft Size selection applies to the spectrum visible in the Spectrum Window. The 

spectrum Buffer soft size can also be selected from the Acquisition Window. The 

selection of the Soft Size from the Acquisition Window and from the Spectrum menu is 

cross-correlated and will display the corresponding soft size for both the Spectrum 

Window and Buffer spectra, but will only actively update the Buffer spectrum. When 
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switching between different soft sizes, the ROI and the calibration coefficients are also 

adjusted accordingly. However, the data used for calculating the calibration parameters 

may not propagate correctly. This may lead to corrupted calibration if the calibration is 

enabled/disabled or recalculated without updating the calibration points for a specific 

soft size. 

The Color command invokes a dialog to adjust the colors used to display the spectrum 

and associated features. Specific colors can be set by pressing the corresponding 

button in the Adjust Colors dialog. To set the default colors, press the Default button. 

The “OK” button will confirm the color selection. The “Cancel” button will disregard any 

color changes. Color settings are stored at the termination of the labZY-MCA application 

and will be restored at the consecutive execution of the software.  

 

Figure 2.1.20. Adjust Colors Dialog. 

The ROI Mode command determines how the ROI (Region of Interest) is marked. To 

understand how to mark an ROI, refer to Mouse and Keyboard Functions. There is no 

limit on the number of marked ROI, besides the limit of available channels in the full 

spectrum. 
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Figure 2.1.21. Spectrum menu → ROI Mode options. 

The Mark Over mode is the default mode. While marking an ROI, any channel the 

cursor is moved over, will be marked as an ROI. All previous ROI that the cursor 

touches or passes over will be connected. Thus, in this mode an ROI will be marked 

between the extremes of the cursor movement, plus any ROIs touched by the cursor at 

its extreme positions. 

The ROI mode From Cursor will mark the ROIs from the current cursor position either to 

the left-end cursor position or to the right-end cursor position. In this mode, only one 

previous ROI can be attached to the newly created ROI. 

 

Figure 2.1.22. Spectrum menu → Copy ROI options. 

The ROIs and the calibration settings can be copied between File and Buffer spectrum 

windows. For this purpose, the Copy ROI and Copy Calibration commands may be 

used. Note that these operations destroy the corresponding settings in the destination. 

Once executed, these operations are not reversible. It is important that the spectrum 

soft size setting is the same for the source and the destination. 

The Copy ROI → File to Buffer and Copy Calibration → File to Buffer commands can be 

used to recall the ROI and calibration data stored in spectrum files to the spectrum 

Buffer. 
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Figure 2.1.23. Spectrum menu → Copy Calibration options. 

 

Utility 

 

Figure 2.1.24. Utility menu. 

The Utility menu has only one command: FPGA. The FPGA command is used to update 

the FPGA design of a connected labZY device. If no device is connected to the labZY-

MCA software the FPGA command will issue a warning message and no further action 

will be performed.  

If a device is connected to the labZY-MCA software the execution of the FPGA 

command will open a dialog (FPGA) that allows the upload of an FPGA design to the 

connected device. 
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Figure 2.1.25. The FPGA dialog. 

To upload an FPGA design, execute the following steps: 

1) Press the button “Browse” to display the “Open” dialog. Browse to the directory of the FPGA 

design file with the extension “.lbf”. Select the file and open it by pressing the “Open” button. 

 

2) Press "Upload" and wait until the design programming file is uploaded. If the upload 

fails, repeat this step. 
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3) For the uploaded FPGA design to take effect either cycle the power of the labZY 

device or execute the “Config FPGA” command. Cycling the power will save the current 

settings of the FPGA. “Config FPGA” will reload the settings of the FPGA from the last 

power on. The FPGA dialog after execution of Config FPGA is shown below. 
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4) The currently stored FPGA design in the labZY device can be verified against an 

FPGA design file (.lbf) by executing the “Verify” command. 

 

 

Help 

 

 

Figure 2.1.26. About labZY-MCA window. 

The Help menu provides version information about the labZY-MCA software. There is 

no provision for interactive help topics at the time of writing this document. 
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Docking Windows 
 

The display information and control functions of the labZY-MCA software are contained 

within docking windows. Docking windows are not permanently attached to the frame of 

the labZY-MCA application. Instead, they can be moved independently or in groups and 

positioned anywhere on the computer screen. The docking windows can be docked at 

the sides of the main frame of the labZY-MCA application. When undocked, like any 

window, these windows can be resized. To group docking windows into one tabbed 

window, drag them and align their title bars. To pull a tabbed window out of a 

tabbed group, grab the window tab and move it away from the group. To restore 

the last position of a window double, click the title bar. 

Spectrum Window 

The Spectrum Window has two tabs. The first tab is the Buffer tab. When the Buffer tab 

is selected, the spectrum from the connected hardware device is displayed in the 

window. The content of the Buffer window is automatically updated by the hardware 

when the Auto Update button of the Acquisition Window is checked. 

The File tab displays spectra loaded from files. When a spectrum is opened, the File tab 

is selected automatically. When the File tab is selected, all hardware controls are 

disabled, including the hardware related toolbar buttons. 

To control the spectrum display or to move the cursor, the Spectrum Window must be 

selected by clicking the mouse within the window. The mouse, the keyboard, and the 

View Control device bar are used to adjust the appearance of the spectra (see Mouse 

and Keyboard Functions). 
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Figure 2.2.1. Sample display of spectra.  

DPP Window 

 

Figure 2.2.2. DPP Window. 

 

The DPP Window contains various controls that are related to the Digital Pulse 

Processor (DPP). Using these controls, the apropriate registers of the labZY devices 

can be modified. Upon connection of a hardware to the labZY-MCA application, the 

fields of the controls are updated with the values from the device’s hardware. Changing 

the fields while the labZY device is connected will also change the corresponding 

device’s registers. 

The labZY FPGA designs implement two digital shapers – Slow and Fast. Both shapers 

synthesise trapezoidal pulses. The Slow Shaper is the main spectroscopy shaper. The 

controls in the DPP group SLOW SHAPER allow adjustment of the Rise Time and the 

Flat Top of the Slow Shaper. The Rise Time of this shaper should be adjusted to 

optimize the signal-to-noise ratio (energy resolution). The Flat Top is adjusted to 

accommodate signals with non-uniform rise times, such as HPGE detectors. In the case 

of HPGE detectors, the flat top duration is typically set between 200ns and 800ns. 

When the rise time variation is negligeable (e.g. silicon drift detectors) the flat top should 

be set to the minimum value of 1. 
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RISE TIME FLAT TOP FALL TIME

Time
 

Figure 2.2.3. Trapezoidal pulses; FALL TIME = RISE TIME 

The fast shaper parameters are set by the controls in the group FAST SHAPER. The 

fast shaper is used to identify the presence of detector events and is used mainly for 

pile-up rejection. Thus, the rise time of the fast shaper is normally set to be much 

shorter than the rise time of the slow shaper. A Rise Time of 50ns to 200ns is typical for 

the fast shaper. 

Both slow and fast shapers are equiped with low-level noise discriminators (LLD). The 

noise discriminator produces an active logic signal when the shaped signal is above a 

noise threshold. The group THRESHOLD contains the controls to set the noise 

discriminator thresholds. The thresholds for the slow shaper noise discriminator (SLOW 

LLD) and the fast shaper noise discriminator (FAST LLD) can be set manually by the 

edit controls SLOW and FAST respectively. Entering zero in these controls will set the 

noise thresholds in Automatic mode (AUTO). The AUTO mode is independently set for 

SLOW LLD and FAST LLD. It is recommended to use AUTO mode for both shapers. 

However, in some cases, a pickup of high frequency or fast rising signals may trigger 

the fast discriminator in AUTO mode causing increased dead time. In such cases, the 

threshold should be adjusted manually until the pick-up signals are rejected by the 

FAST LLD and the dead time is reduced. The Auto Margin control allows the addition of 

extra noise immunity to automatically set thresholds. The Auto Margins are ignored 

when the thresholds are set manually. 

When the noise thresholds are in auto mode, the thresholds are set by the hardware 

internal noise estimation circuit. This circuit estimates the thresholds using a statistical 

technique based on a Gaussian probability density function of the noise distribution. The 

threshold estimation is shown in the group EST. THRESHOLD, which are read-only 

controls. The estimated thresholds are always ewaluated and displayed regardeles of 

the threshold settings - Auto or Manual. 
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Figure 2.2.4. A pulse signal is characterized by LONG TC and SHORT TC. 

The DPP of labZY devices is designed to accept exponential signals with two real poles 

characterized by a long time constant (LONG TC) and a short time constant (SHORT 

TC). The DPP has two functional stages. The first stage unfolds the input pulses by 

removing the two exponential responses coresponding to the two real poles of the 

signal. That is, the result of the unfolding function is a unit impulse. The unit impulse is 

fed to the second stage which performs a synthesis of trapezoidal/triangular pulse 

shapes.  

 

LONG TC

UNFOLDING

SHORT TC

UNFOLDING

TRAPEZOIDAL

PULSE SHAPE

SYNTHESIS

UNFOLDING SYNTHESIS

 

Figure 2.2.5. Unfolding to synthesis. 

 

Signals connected to Input A of the nanoMCA(-SP) and nanoMCA-II (-SP) are 

conditioned internally by a differentiation (or pole-zero compensating) circuit which 

determines the LONG TC. The nanoXRS has a similar arrangement, except that the 

detector signal is internally connected. The expected optimal LONG TC of the 

exponential signals at Input B should be obtained from the corresponding labZY device 
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data sheet. The nanoDPP accepts externally conditioned signals at both inputs.The 

SHORT TC normally depends on the response of the amplifiers in the amplification 

chain including the rise time response of the preamplifier connected to Input A. The 

SHORT TC may also represent the decay time constant of scintillation detectors.  

The LONG TC and the SHORT TC should be adjusted to minimize the tailing and/or the 

undershoot of the digitally shaped pulses (both the slow and fast shapers). SHORT TC 

has more influence on the fast shaper, while the LONG TC will affect both shapers. 

Adjustments of the time constants is performed using the Trace Viewer. A slow shaper 

rise time of 2μs or longer is recommended to adjust the LONG TC. SHORT TC should 

be adjusted using the pulses from the fast shaper. 

The labZY devices are delivered with the Input A LONG TC already adjusted to match 

the time constant of the internal differentiation network. The SHORT TC of Input A may 

need to be readjusted if the external signal sources have a rise time that is slower than 

the internal amplifier rise time. 

The group UNFOLDING provides means for adjustment of the LONG TC and the 

SHORT TC. The controls are independent for Input A and Input B. These controls are 

automatically selected when the input of the labZY device is selected in the SIGNALS 

window. The active Input A or B is indicated next to the group name UNFOLDING.  

The trapezoidal pulse shape synthesis can be represented as a convolution of two 

rectangular impulse responses. The peak value of the trapezoidal pulse represents the 

area under the shorter of the two rectangular impulse responses. The rise time of the 

trapezoidal pulse is equal to the width of the shorter rectangular impulse response. 

Therefore, the synthesis introduces gain equal to the rise time of the trapezoidal pulse 

shape. In addition, the ADC resolution differs from the total number of channels in the 

spectrum. These conditions require a normalization of the peaks of the digitally 

synthesized trapezoidal pulse shapes. The group PEAK NORMALIZATION presents a 

control for manual adjustment, the peak normalization FACTOR. Although this 

adjustment is available, it is strongly recommended to use the automatic normalization 

by checking the AUTO checkbox. The normalization FACTOR in auto mode is a linear 

function of the SLOW SHAPER rise time – [FACTOR]=2.5[SLOW SHAPER]. The FINE 

checkbox compensates for the difference of the LONG TC setting and the expected 

LONG TC, as coded into the FPGA design. It is safe to have both AUTO and FINE 

checked at the same time. 

The ballistic deficit correction factor, BDC, is used to optimize the usage of the ADC 

range so that the signals are digitized by utilizing most of the ADC quantization levels. 

For fast rising signals (silicon detectors, fast scinitllators) and signals with large variation 

in rise time (HPGE), the BDC should be set to 1. Setting BDC to 1 is always a safe 
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choice. However, for optimum utilization of the ADC range the BDC can be adjusted 

using the Trace Viewer. The adjustment procedure is described in Appendix B.  

The main function of the fast shaper, along with the FAST LLD, is pile-up rejection 

associated with the slow shaper. Note that the fast shaper pulses are also subject to 

pile-up. When such pile-up occurs, the FAST LLD pulses will be treated as a single 

event pulse and pile-up rejection will fail.  

The BLR RESPONSE group controls the BLR of the SLOW and FAST shapers. The 

response of the BLR is inversly proportional to the value set for SLOW or FAST. A 

smaller number means more agressive BLR. For moderate counting rates, the BLR 

response should be in the range of 200 to 500. For higher counting rates, the range 

should be between 20 to 200. The symmetric (SYM) mode of the BLR is recomended 

for the SLOW shaper. Depending on the counting rates and the undershoots of the 

detector signals, the SYM mode will require carefull evaluation to determine whether or 

not to use it. 

The ACC mode of the BLR is a special mode when AC coupled detectors have non-

linear response and cause severe undershoot  when recovering from overload 

condition. This situation is rare and in most cases ACC will be left unchecked. When 

ACC is checked the BLR operates in fast recovery mode when overload caused by the 

detector signals is detected - the INHIBIT signal becomes active LOW. Fig. 2.2.6 

depicts traces of ADC signal with undershoot, and the recovery of the slow shaper with 

and without engagement of the ACC. Avoid to use ACC mode unless the overload of 

the detector causes degradation of the resolution or a severe shift of the base line. 

 
a)    b)    c)  

Figure 2.2.6. a) Overloaded detector signal; Slow Shaper - b) without ACC, c) with ACC. 

 

To improve the pile-up capability of the fast discriminator, a pulse-shape anlysis of the 

fast pulse shape is performed (Fig. 2.2.7). The pile-up rejection capability of the labZY 
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devices can be improved by checking the ENHANCED checkbox in the PILE-UP 

Rejector group. The enhanced pile-up rejection algorithm does not use timing 

information and is not sensitive to pulse-tailing. In rare cases the ENHANCED pile-up 

rejection may be sensitive to high frequency pick-up signals. 

Fig. 2.2.7 illustrates normal pile-up rejection (c) and enhanced pile-up rejection (d) as 

seen by the Trace Viewer. The signal trace depicts the fast pulse shape. The Trace 

Viewer is triggered by the internal pile-up rejector signal which has an active low logic 

level. 

DISTORTED
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SHAPE

FAST
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DISCRIMINATOR

PILE-UP

REJECTOR REJECT

a) b)

NORMAL

PULSE 

SHAPE

 

         
   c)      d)  

Figure 2.2.7. a) Pile-up free fast shaper/discriminator; b) Fast shaper pile-up and pulse-shape 

distortion; c) Example -traditional pile-up rejection; d) Example - enhanced pile-up rejection. 
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SIGNALS Window 

 

 

Figure 2.2.8. SIGNALS Window. 

The SIGNALS Window contains the controls of the analog signals, analog signals-

related functions, and configuration of the logic signals functions of the labZY devices. 

The MCA devices have two analog signal inputs: Input A and Input B. The signal of only 

one of these inputs can be processed at a time. IMPORTANT! Disconnect any signal 

sources from the unused analog input as this may create an interference with the 

active input. Note that some digital signals may not be available for a given labZY 

device - refer to the specific data sheet for more information. 

 

Figure 2.2.9. Analog Inputs A/B options. 

The group ANALOG INPUTS A/B allows selection of the active input and its polarity. 

There is also Auto Polarity mode. Auto Polarity mode requires a detector signal 

producing at least one thousand counts per second to be connected to the detector 

signal inputs of the labZY devices. The detected polarity is displayed on the left of the 

selection window: (+) for positive signals and (-) for negative signals. Auto Polarity 

should be used only to find the signal polarity of unknown sources. If the signal polarity 

is known, or after the Auto Polarity finds the correct polarity, the input selection should 

be made from the choices showing the explicit signal polarity. 

The INPUT C group contains controls related to the logic signal fed to Input C. The 

active logic level of this signal is selected from a drop-down list. The AUTO function 
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should only be used when the active logic level of the signal source is unknown. The 

active logic level selection is ignored when nanoXRS or nanoDPP are connected to the 

labZY-MCA application.  

               

Figure 2.2.10. Input C options. 

The Inhibit Extension sets an extension of the Input C active state. This extension 

should be long enough for the digital shaper to recover after an overload due to ramp 

resets of reset-type detector preamplifiers. 

The DIGITAL IO group contains controls for the digital IO functionality.  

                   

                 

Figure 2.2.11. DIGITAL IO options. 
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Signal D is an input-only signal and can accept either analog signals or digital signals. 

The analog signals applied to this input are digitized by a slow ADC. The digital signals 

applied to Input D can be used by the coincidence circuits built in the hardware. 

The digital signal R is an input/output signal. Signal R is available only in nanoMCA-II(-

SP) devices. Input R can be used as a source for coincidence/anticoincidence and 

should be preferred over Input D. Signal R can also be used as an output. The signal R 

output function is automatically disabled when signal R is enabled as an input. 

The DIGITAL OUTPUTS group contains controls for the digital outputs that are only 

available in nanoMCA-II(-SP) devices.  

 

 

Figure 2.2.12. DIGITAL OUTPUTS configuration options. 

The OFFSET group relates to, and is of extreme importance for, the operation of the 

ADC and DPP. Offsets are especially important for the proper operation of the ADC. 

The offset concept and associated requirements are completely different from the old 

understanding and requirements used in analog based pulse shapers and spectroscopy 

ADC. IMPORTANT! The "zero offset" of the recorded spectra is not affected by 

these offsets. These are signal processing related offsets only. An offset at the 

input of the ADC allows digitization of the negative portion of the noise. The analog 
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offset at the input of the ADC is referred to as the AMPLIFIER OFFSET. The digital 

offset that is subtracted from the digitized signal is the ADC OFFSET. The AMPLIFIER 

OFFSET should be adjusted so that its digital equivalent is cancelled out by the ADC 

OFFSET.  
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Figure 2.2.13. Offset cancellation. 

 

It is recommended that both the ADC DEFAULT and the AUTO options are used, 

and the corresponding ADC DEFAULT and AUTO buttons are depressed. The 

labZY hardware incorporates automatic adjustment of the AMPLIFIER OFFSET so that 

it can be cancelled exactly by the ADC OFFSET.  
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Figure 2.2.14. Offset group. 

Some measurements (e.g. the PHA of bipolar signals) may require manual adjustment 

of the AMPLIFIER OFFSET. To manually adjust the AMPLIFIER OFFSET, use the 

Trace Viewer window and the SAR button of the OFFSET group. Be sure to remove 

any radiation sources and to reduce the counting rate to as low as possible 

before making any adjustments. In the Trace Viewer window, set the Acquisition 

Mode to RND, the Horizontal setting to 20 µs/div, the Vertical setting to 4k/div, and the 

Vertical Offset setting to zero (press the “0” button). Then select ADC in the Input 

section and press the RUN button of the Trace Viewer. 

In the OFFSET section of the SIGNALS Window, turn AUTO off and press the SAR 

button. The AUTO button will become inactive (grayed out). Observe the ADC trace in 

the Trace Viewer window. The ADC trace will shift upwards or downwards. The goal is 

to adjust the position of the ADC trace to the middle of the window. If the ADC trace is 

above the zero line (aligned with the Offset pointer), press the “--” button of the OFFSET 

section in the SIGNALS Window. If the ADC trace is below the zero line, press the “++” 

button. After pressing either button, wait at least five seconds until the ADC trace 

settles. Continue the sequence of pressing the “--” and “++” buttons according to the 

position of the ADC trace until the SAR button becomes active and the “--” and “++” 

buttons are greyed out. You may terminate this procedure by pressing the AUTO 

button. You may need to adjust the Vertical Offset for more precise adjustments of the 

Amplifier OFFSET. The Amplifier OFFSET may be fine-tuned by modifying the offset 

value in the AMPLIFIER edit box. For more information about offset adjustments, 

please visit the support section of labzy.com.  

The GAIN group has controls to adjust the analog gain. The coarse gain is adjusted in 

steps. When Input A is a signal source (except for the nanoXRS) there are 32 coarse 

gain values to choose from in the drop-down list COARSE. These values are defined as 

2N/4, where N = 0 to 31. In the case of nanoXRS, or when Input B is selected, there are 

only 4 coarse gain settings defined as 2N/2, where N = 0 to 3. 
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    a)         b)    

Figure 2.2.15. Coarse Gain selection a) Input A (except nanoXRS); b) Input B or nanoXRS.  

The FINE control can be used to fine-tune the analog gain. The range of the fine gain is 

from 1 to 1.2, adjustable in 65536 steps. Thus, for Input A, the analog gain is virtually 

continuous covering a range from 1 to 255. The read-only TOTAL field reports the total 

analog gain by multiplying the fine gain and the coarse gain.  

The preamplifier group offers a choice for the external preamplifier type connected to 

Input A. When the resistive type is selected, the pole-zero can be adjusted manually 

using the P/Z control and the Trace Viewer.  

 

                    

Figure 2.2.16. Preamplifier Type options. 

 

It is also possible to adjust the pole-zero automatically using the Auto Pole-Zero group. When 

the preamplifier type is RESET, the START APZ button is grayed out. When the external 

preamplifier is RC the button START APZ can be pressed. Once this button is pressed its 

caption changes to STOP APZ and the process of automatically adjusting the PZ begins. The 

vertical progress bar is initially filled and gradually decays as the adjustment process proceeds. 

When the progress bar is empty, the automatic pole-zero adjustment (APZ) has completed. The 

progress of the adjustment can be viewed on the Trace Viewer and can be stopped manually if 

the adjustment has reached a satisfactory level prior to the progress bar being empty. To stop 

the automatic pole-zero adjustment simply press the STOP APZ button. The automatic pole-

zero adjustment routine is implemented in hardware and does not depend on the labZY-MCA 

software. The adjustment will complete even if the labZY-MCA software is disconnected while 

the APZ is active. 
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Figure 2.2.17. Automatic pole-zero adjustment controls. 

The STABILIZER group allows for setting and controlling the gain stabilizer of the labZY 

devices. The stabilizer adjusts the fine gain of the device. Therefore, in order to use the 

stabilizer, the fine gain must be set at the middle of its scale: 1.10. The stabilizer offers 

a maximum of 10% correction of the gain. Normally, the stabilizer is used with 

scintillation detectors which are sensitive to temperature variations. The stabilizer uses 

a reference peak from the acquired spectrum. For best results the centroid of the peak 

must be larger than half of the spectrum scale. Pressing the SET button will open a 

dialog. To automatically set the parameters of the stabilizer, mark an ROI around the 

desired peak for stabilization and press the long button to generate recommended 

settings. You may also manually enter the peak parameters. To start the stabilization, 

check the Enable box. It is important to let the stabilizer run for some time before 

starting an acquisition. The stabilizer is implemented in hardware and its operation is 

independent of the labZY-MCA software. 

        

Figure 2.2.18. Stabilizer controls. 

 

Figure 2.2.19. Stabilizer Setup Dialog. 
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PHA Window 

 

 

Figure 2.2.20. PHA Window 

 

 

The PHA Window is only available for the nanoMCA and nanoMCA-II, when their Input 

B is configured to accept pulses from analog shapers (About Hardware: Primary TC B is 

0). The PHA functionality requires a special FPGA design (FPGA designs ending with -

PHA), which is the default FPGA design that is loaded into the nanoMCA and 

nanoMCA-II upon shipment from the factory. 

 

Acquisition Window 

 

The ACQUISITION Window contains the spectrum acquisition parameters and 

acquisition control settings. 
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Figure 2.2.16. Acquisition Window. 

The AUTO UPDATE checkbox controls the data exchange between the labZY-MCA 

software and the connected hardware. To continually update all data from the hardware, 

this checkbox must be selected. When the Trace Viewer is in acquisition state, this box 

is automatically unchecked to improve the update rate of the Trace Viewer. It is possible 

to recheck the box while the Trace Viewer is acquiring data; however, the update rate of 

the spectrum and the Trace Viewer will be reduced noticeably.  

Selecting the DIGITAL PULSER will enable the hardware built-in digital pulser. The 

digital pulser data is stored in channels 15000 to 16383 of the hardware spectrum. 

When the digital pulser is enabled, the spectrum is stored in channels 0 to 14999. The 

centroid of the digital pulser peak is offset relative to the spectrum zero channel by 

15692 channels. This offset can be used to assess baseline offsets. 
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The preset time of the spectrum acquisition is set by the controls in the group TIME. 

The preset time can be either LIVE TIME or REAL TIME. The preset time can be set in 

seconds. The TIMERS group reports the elapsed real and live time. The dead time is 

also reported.  

The spectrum acquisition is controlled by the following buttons: START, STOP, RESET. 

START, STOP and RESET are also available as buttons of the HARDWARE 

CONTROL toolbar. 

The DATE/TIME button opens a dialog to select a time stamp for a given measurement. 

 

 

Figure 2.2.20. Timestamp Dialog. 

The time stamp may use UTC, LOCAL or SYSTEM time. the UTC can be obtained from 

an internet time server with an accuracy of less than 50ms. The time stamp stored in 

the hardware will be with an accuracy of 1s. If UTC is selected, the labZY-MCA software 

will automatically open the dialog seen in Figure 2.2.20 when selecting START or 

RESET if more than 300s have expired from the last internet time synchronization with 

an NTP time server. It is possible to synchronize a local host clock with the obtained 

NTP time; this function, however requires that the labZY-MCA is run with administrator 

privileges (run as administrator). 

The Acquisition Window also displays the volatile data such as temperature, voltages, 

power, etc. The volatile data changes constantly. When stored in files, the volatile data 

represent the volatile state at the time the file is being saved. 
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The COINCIDENCE group is used to set-up the coincidence/anticoincidence function of 

the labZY devices. The coincidence function uses Input D or Input R (settings from the 

SIGNALS Window) that drive an internal COINC S signal. COINC S can be a direct 

coincidence source or indirect coincidence source by edge-triggering a coincidence 

window pulse. In either case, the resulting signal (direct or indirect) is a COINC W 

signal. The coincidence/anticoincidence is between the internal STORE signal derived 

from the timing peak detector signal, and the COINC W signal. 

            

Figure 2.2.21. Coincidence Controls. 

The coincidence function is selected from the drop-down list. This selection has no 

effect on the nanoXRS, as it does not have external logic signal connectors. When 

DISABLED is selected, the coincidence/anticoincidence circuit is disabled. 

When DIRECT is selected the COINC W is directly related to COINC S. Note that the 

COINC S can be active high or active low depending on the Input D or Input R function 

selection in the SIGNALS Window.  The COINC W is in coincidence with the STORE 

signal when high and in anticoincidence when low. By selecting (in the SIGNALS 

Window) the polarity (inverted or not) of Input R or Input D the coincidence and 

anticoincidence functions can be reversed in the DIRECT mode. 

When one of the WINDOW coincidence functions is selected, a window logic signal is 

generated by a One-Shot pulse generator at  the low-to-high transition of COINC S. The 

width of the window logic pulse is set in the Win Width control. In this mode the 

COINC W is directly tied to the output of the One-Shot pulse generator. 

The COINC W signal can be delayed to align with the internal, peak-detector derived 

signal, STORE. The delay is set by the Src Delay control. The COINC_W can be 

selected to function as coincidence or anticoincidence signal. 

The internal STORE signal can be delayed to accommodate coincidence or 

anticoincidence with external signals that may have long propagation delays, or when 
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they become active after the internal peak detection signal of the labZY devices. The 

STORE signal delay is set by the Peak Delay control. Adjustments of the delays and the 

coincidence window width can be accomplished using the Trace Viewer. Double 

pressing the Input C trigger button will switch the Input C trace to COINC S and the 

INHIBIT trace to COINC W. 
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Figure 2.2.22. Timing diagrams of the built-in coincidence circuit: a) Coincidence source 

COINC S as DIRECT coincidence signal; b) COINC S as DIRECT anti-coincidence signal; c) 

and d) positive edge coincidence/anti-coincidence triggered signals with controlled coincidence 

window width. Parameters in italic are controlled by the software. 
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The  SPECTRUM LOGGER allows repeated spectrum acquisition and storage. The logger is 

implemented in the labZY-MCA software and requires active connection with a labZY device 

during the entire time of measurement and logging the spectra. 

The logger allows repeated storage of spectra acquired at identical settings for a preset 

number of RUNS. Each run of the logger represent a single spectrum acquisition for the 

preset LIVE or REAL time. At the end of the run the spectrum is stored, the spectrum 

memory is reset and a new spectrum acquisition is initiated. There is a gap between the 

runs. The minimum gap time is 1s or 2s when the REAL preset spectrum acquisition 

time is an odd number or even number of seconds respectively.  The gap may be longer 

depending on the speed of the computer to write the acquired spectra.  

The spectra are stored in files with file names that are combination of the FILE NAME 

(BASE) and the number of the run (starting with 1) saved in the file as shown below - 

five runs with base file name gamma-ray_spectrum: 

 

The storage folder is selected by pressing The FOLDER button. To start the logging the 

box  ENABLE is checked followed by a press of the START button. To stop the logging 

before the preset numbers of spectrum records are reached the ENABLE box must be 

unchecked. 

Each spectrum is time stamped. The time stamp of the first spectrum can be UTC 

synchronized or synchronized with the computer clock. a selection that can be made by 

pressing the TIME STAMP button before enabling the logger. The time stamps of all 

measurement following the first measurement are derived from the computer clock 

directly or  by applying the initial UTC offset if the UTC time stamp is used for the first 

measurement. The cock time drift can be estimated by finding the UTC offsets at the 

beginning and the end of the measurement. Consequently the time stamps of the 

individual measurement can be corrected using the clock uncertainty and drift 

measurements. 

The logging process will be terminated if the connection between the labZY-MCA and 

the labZY device fails due to power failure or communication errors or time out 

conditions. 
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Calibration Window 

The Calibration Window contains the energy calibration settings. The labZY-MCA 

device utilizes up to 10 points to conduct a second-order calibration. This calibration 

uses selected channel-energy points to solve for the coefficients a, b, and c of the 

equation: EN = aCH^2 + bCH + c. 

 

To set the calibration coefficients, up to 10 channel-energy points 

can be used. The available points are listed in the CALBIRATION 

POINTS table. Selecting (check-marking) a subset of the 

CALIBRATION POINTS and clicking Calibrate with Selected Points 

will calibrate the spectrum using the selected points only. 

Alternatively, clicking Calibrate with All Points will conduct the 

calibration using all points listed in the CALIBRATION POINTS 

table. Note that at least two points are required for calibration. 

Channel-energy points can be added to the CALIBRATION POINTS 

table via the CHANNEL and ENERGY interfaces. The entry of the 

CHANNEL data can be manual, by ROI PEAK centroid, or by 

CURSOR position, while the ENERGY values must be entered 

manually. To enter a PEAK centroid CHANNEL, select an ROI of a 

spectral peak in the spectrum window, place the spectrum cursor 

within the ROI using the left mouse button, and press the PEAK 

button. To enter a CURSOR position, move the spectrum cursor to 

the desired channel in the spectrum window by pressing the left 

mouse button, and press the CURSOR button. Press ADD POINT 

to transfer the CHANNEL/ENERGY values as a calibration point to 

the CALIBRATION POINTS table. 

To edit calibration points, select (check-mark) the points to be 

edited and press the Edit Selected Points button once. This will 

populate the CHANNEL/ENERGY fields with the first selected point 

in the table, while simultaneously removing that point from the table. 

Edit the CHANNEL/ENERGY fields as desired, and click ADD 

POINT to add the new, edited point to the calibration points table. 

Repeat this process until all selected points have been edited. 

Calibration points can be removed by first selecting the relevant 

points (check-marking) and then pressing the Remove Selected 

Points button. Clicking Remove All Points will remove all calibration 

points from the table.  

Figure 2.2.23. Calibration  
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The calibration units are selected from the drop-down choice list. Checking the ENABLE 

CALIBRATION box will display the spectrum information in calibration units.  

Spectrum Info Window 

The Spectrum Info Window displays read-only information about the 

spectra and acquisition-related information. 

The CURSOR group displays the position of the spectrum cursor in 

channels or calibration units. The counts of the channel at the cursor 

position are also reported. 

The PEAK INFO group provides peak info when the spectrum cursor 

is within an ROI marking a spectral peak. The CENTROID, FWHM 

and FWTM are displayed either in channels or in calibration units. 

The TIME group displays the state of the hardware timers. This 

information is also available as part of the Acquisition Window. The 

Dead Time is calculated based on the total elapsed time. The 

reported Dead Time will not change when the spectrum acquisition is 

stopped. 

The COUNT RATE group provides life information independent of 

the spectrum acquisition state. The counting losses are an indication 

of the dead time on a short time scale. At low counting rates, the 

reported losses may show large variations due to statistical 

fluctuations. For accurate measurement of the Dead Time, the Dead 

Time reported in the TIME group should be used. 

The INCOMING count rate is derived from the fast discriminator 

counting rate corrected for the pile-up losses. The correction is 

based on the parameters of the fast shaper and the counting 

statistic. Caution should be exercised when interpreting the counting 

losses of periodic test signals as their time intervals are not randomly 

distributed. Incorrect setup of the coincidence 

circuit or the inhibit signal may cause very large counting losses, 

approaching 100%. Similarly, very low noise thresholds may cause 

the fast discriminator to respond to noise, which will also lead to 

increased counting losses. 

The CAL check box mirrors the functionality of the Enable Calibration 

check box of the Calibration Window.  

Figure 2.2.24. Spectrum Info  
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Trace Viewer Window 

 

 

Figure 2.2.19. Normal size Trace Viewer Window. 

The Trace Viewer acts as a mixed signal oscilloscope and can be used to set and verify 

parameters, to debug hardware configurations and FPGA designs, and to investigate 

detector signal features. 

The Trace Viewer is a docking window and can be resized. The resizing, however, 

differs from the resizing of the other docking windows. The Trace Viewer can be 

displayed in only two sizes – normal and large. When resizing from normal to large, the 

sizing will take effect if the size of the window frame exceeds the large. When sizing 

down to normal size, the sizing will take affect if the size of the frame becomes smaller 

than the normal size.  

 

Figure 2.2.20. Large Size Trace Viewer Window  
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The Trace Viewer is a hybrid solution using hardware resources and software functions 

to capture and display one digital signal waveform and eight logic signal traces. The 

Trace Viewer includes various controls for setting the hardware and selecting the 

software features. 

ACQUISITION
MODE

ACQUISITION
CONTROL

DIGITAL
SIGNAL

VERTICAL
OFFSET

LOGIC
SIGNALS

TRIGGER
POSITION

DISPLAY
CONTROLS

TRIGGER
CONTROLS

DIGITAL
SIGNAL

SELECTION

 

Figure 2.2.21. Controls and features of the Trace Viewer. 

The trace display window displays the digitals signal and the logic signals. The position 

of the logic signals is fixed. The digital signal can be displayed with an offset that is 

selected within the trace display window by the VERTICAL OFFSET control. The 

vertical offset can be reset to zero by pressing the zero button  in the Vertical Offset 

group. 
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The horizontal time scale can be selected using the Horizontal control by pressing the + 

or – buttons. The vertical scale is chosen from preset values by pressing the + or – 

buttons of the Vertical control.  

The trace acquisition is controlled by two buttons: ACQUISITION CONTROL and 

ACQUISITION MODE. There are seven acquisition modes that can be selected by 

consecutively pressing the ACQUISITION MODE button.  

 

NRM SGL Av2 Av4 Av8 Av16 RND

 

Figure 2.2.22. Acquisition Mode selection sequence using the ACQUISITION MODE button 

 

The selected acquisition mode is displayed as a caption of the ACQUISITION MODE 

button: 

  Continuous, triggered acquisition. No averaging of the digital signal. 

  Single, triggered acquisition. No averaging of the digital signal. 

  Continuous, triggered acquisition. 2 samples averaging of the digital signal. 

  Continuous, triggered acquisition. 4 samples averaging of the digital signal. 

  Continuous, triggered acquisition. 8 samples averaging of the digital signal. 

  Continuous, triggered acquisition. 16 samples averaging of the digital signal. 

  Continuous, random acquisition. 

The Trace Viewer can be in three acquisition states: stopped, continuous acquisition 

and single acquisition. When the hardware is not connected, the Trace Viewer is always 

in the stopped state. In the stopped state, the ACQUISITION CONTROL caption 

displays “RUN”. To enter the acquisition states, a connection with the hardware must be 

established. 

The single acquisition state is entered by pressing the ACQUISITION CONTROL button 

when its caption displays “RUN” and the acquisition mode is SGL. After this, the 

ACQUISITION CONTROL button will remain depressed and its caption will change to 

“ACQ”. After the single trace acquisition is recorded, the Trace Viewer re-enters the 

stopped state. 
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The continuous acquisition state is entered by pressing the ACQUISITION CONTROL 

button when its caption displays “RUN” and the acquisition mode is not SGL. The 

caption of the ACQUISITION CONTROL button changes to “STP” and remains pressed. 

To exit the continuous acquisition state, press the depressed ACQUISITION CONTROL 

button when its caption displays “STP”. 

The Trace Viewer displays one digital signal waveform, which can be selected from four 

different sources. The selection of the digital signal is done by depressing one of the 

four buttons in the Input group. SLOW is the slow shaper signal, FAST is the fast 

shaper signal, ADC is the digitized analog signal after the subtraction of the ADC 

OFFSET. AUX is the same as SLOW in the standard labZY devices. AUX can be 

connected to other internal digital signals in customized designs. 

The Trigger group contains controls to select trigger source for continuous or single 

triggered acquisitions. The trigger can be selected only from the logic signals. The 

INVERT button defines the trigger edge. When this button is not depressed, the low-to-

high transition of the trigger signal is the acquisition trigger edge for all traces. When the 

button is depressed, the high-to-low transition is the trigger edge. 

The trigger source can be selected by depressing one of the eight trigger buttons in-line 

with the logic signal traces. The captions of these buttons also serve as labels for the 

logic signal traces. The F LLD and S LLD are the fast and the slow low-level 

discriminators, respectively. The PKDT is the peak detection logic strobe signal. The 

STORE is the signal that triggers increments of the channels. PUR is the pile-up 

rejection logic signal. INHIBIT is the internal inhibit signal, which disables the base-line 

restorer and the spectrum acquisition. INHIBIT is generated not only when Input C is 

active, but also when the ADC overflows. The INHIBIT button may change to COINC W 

(coincidence window) button depending on the state of Input C button. The Input C 

button is a dual-purpose button: when depressed and clicked, this button changes its 

own functionality as well as the functionality of the INHIBIT/COINC W button. There are 

two pairs of button options, indicated by the corresponding button options: the first pair 

is Input C + INHIBIT and the second pair is Input D + COINC W. This allows a total of 

ten logic signals to be used as triggers and their traces displayed. 

The ROI trigger is a very special and useful option, allowing triggering by events with 

pulse heights corresponding either to a range of channels, or to a single channel. When 

using the ROI trigger, one can identify the cause of anomalies in the spectrum by simply 

marking an ROI and setting the ROI trigger to only those events contributing to the ROI 

channels. To set the ROI trigger, place the spectrum cursor within an ROI and press the 

ROI trigger button. If the ROI trigger button is depressed and pressed again, the ROI 

boundaries displayed in the Trace Viewer will be updated to the boundaries of the ROI 

that the spectrum cursor is placed in. 
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CURSOR

ROI

 

 

Figure 2.2.23. Setting the ROI trigger 

 

The Trace Viewer uses a pre-trigger acquisition to capture portions of the signals 

preceding the trigger. The trigger position can be adjusted by the slider TRIGGER 

POSITION. This allows a larger or smaller portion of the pre-trigger signal to be 

captured and displayed. 

The PEAK button and the associated function are unique to the labZY Trace Viewer. 

When this button is depressed, each digital signal waveform is automatically zero-

referenced to its peak. This allows detailed investigation of the peaks of the signals, as 

the vertical scale can be set to small values without losing the ability to observe the 

peaks of the digital signal. The PEAK mode and the ROI or PKDT triggers allow for fine 

adjustment of the LONG TC by observing the flat top of the digital signal at the highest 

possible vertical resolution.  
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Debug Window 

 

Figure 2.2.24. Debug Window. 

 

The Debug Window has the direct controls of the FPGA internal registers and can be 

used as a custom design debug device. When the AUTO READ is selected, the 

registers will be updated automatically.  

 

Events Window 

 

Figure 2.2.25. Events Window. 

Various system level events are displayed in the Events Window. 
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Device Bars 
 

Standard 

 

   Figure 2.3.1. Standard device bar. 

Button function from left to right: 

  Information about labZY-MCA software. 

  Open file. 

  Save spectrum as... 

  Restore Layout. 

  Default Layout. 

 

Hardware Control 

  Figure 2.3.2. Hardware not connected. 

  Figure 2.3.3. Hardware connected. Spectrum acquisition stopped. 

  Figure 2.3.4. Hardware connected. Spectrum acquisition in progress. 

Button function from left to right: 

  Automatic search for ports and automatic connection. 

  Manually select port. 

  Connect to hardware. 

  Disconnect from hardware. 

  Erase spectrum and reset timers = RESET. 

  Start spectrum acquisition = START. 

  Stop spectrum acquisition = STOP. 
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View Control 

 

   Figure 2.3.5. Viewer Control device bar. 

Button function from left to right: 

  Linear vertical scale. 

  Logarithmic vertical scale. 

  Automatic vertical scale. 

  Expand vertically. 

  Condense vertically. 

  Expand horizontally around the cursor. 

  Condense horizontally around the cursor. 

  Expand horizontally from the left spectrum view border. 

  Condense horizontally towards the left spectrum view border. 

  Display the full spectrum. 

 

Mouse and Keyboard Functions 
 

The Mouse and the Keyboard are used to navigate and operate the windows and their 

controls. In the Buffer and File Windows, the mouse and the keyboard are used to move 

the spectrum cursor, to mark or unmark regions of interest (ROI), and to adjust the 

spectrum view. Use the SPACE BAR to toggle the spectrum display between: a filled 

histogram (default), dots, a step function, and a line. 

 

Selecting and Moving the Cursor 

 

To select the cursor, first click the right or left mouse button anywhere within the Buffer 

Window or the File Window. The cursor will be positioned at the point of the mouse 

click. To move the cursor, press and hold either the left button or the right button of the 
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mouse. Alternatively, the cursor may be moved left or right by pressing the LEFT 

ARROW KEY or the RIGHT ARROW KEY of the keyboard respectively.  

 

Marking/Unmarking ROI 

 

To mark an ROI, use the sequence shown below, or press SHIFT+LEFT ARROW KEY 

or SHIFT+RIGHT ARROW KEY respectively. 

PRESS

AND 

HOLD

FIRST

     

PRESS

AND 

HOLD

SECOND

HOLD

     

HOLD HOLD

MARK ROI

 

Figure 2.4.1. How to mark an ROI using the mouse. 

To unmark an ROI, use the sequence shown below, or press CTRL+LEFT ARROW 

KEY or CTRL+RIGHT ARROW KEY respectively. 
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PRESS

AND 

HOLD

FIRST

     

PRESS

AND 

HOLD

SECOND

HOLD

     

HOLD HOLD

UNMARK ROI

 

 

Figure 2.4.2. How to unmark an ROI using the mouse. 

 

Controlling the Spectrum Display 

 

The mouse can be used to control the number of spectrum channels displayed within 

the Buffer Window or the File Window. A double click of the LEFT mouse button 

reduces the number of channels shown within the window - expanding horizontally. A 

double click of the RIGHT mouse button increases the number of channels shown 

within the window - condensing horizontally. The mouse horizontal control functions are 

shown below. 
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DOUBLE

CLICK

EXPAND 

HORIZONTALLY

     

DOUBLE

CLICK

CONDENSE 

HORIZONTALLY

 

 

Figure 2.4.3. How to expand and condense the spectrum display horizontally. 

 

The "I" KEY and the "O" KEY can also be used to expand and condense the spectrum 

display horizontally. The section of the spectrum displayed in the Buffer Window or the 

File Window can be selected by sliding the bar of the horizontal slider or by "bumping" 

the cursor to the left or the right borders of the spectrum display window. 

The mouse and the keyboard can also be used to control the spectrum display 

vertically. The vertical control of the spectrum display determines the number of counts 

displayed within the vertical boundaries of the Buffer Window or the File Buffer. The 

vertical scale is controlled by the MOUSE WHEEL, the UP ARROW KEY of the 

keyboard, the DOWN ARROW KEY of the keyboard, or the vertical sliding bar. The 

MOUSE WHEEL function is illustrated below. 
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CONDENSE  

VERTICALLY

     

EXPAND 

VERTICALLY

 

 

Figure 2.4.4. How to expand and condense vertically the spectrum display. 
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Appendix A: labZY File Format (.lzs) 
<?xml version="1.0"?>

<nanoMCA-II>

 <serialnumber>23005</serialnumber>

<spectrum>

  <tag>nanoMCA-II-SP, Cs-137, NaI 3"x3"</

tag>

  <hardsize>16384</hardsize>

  <softsize>4096</softsize>

  <data>

0

0

0

82

44

.

. 

.  

.   

.    

.  

346

+567

+1054

+1109

+985

+605

588

587

597

561

.

.

.

.

5

2

0

1

  </data>

</spectrum>

Counts from Channel 0 to Channel 16383. 

An explicit + sign in front of the channel 

counts indicates that the corresponding 

channel is marked as an ROI.

Spectrum tag and spectrum 

size information.

Hardware
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Hardware Register record

Register 0 to Register 127.

Time information.

<time>

  <real> 2000.0000</real>

  <live> 1954.4138</live>

  <dead>    2.2793</dead>

  <date>17 APR 2014 @ 19:20:04</date>

</time>

<registers>

  <size>128</size>

  <data>

0

8000

160

20

8

.

.

.

.

0

0

0

  </data>

</registers>

<calibration>

  <enabled>YES</enabled>

  <units>2</units>

  <channelA>  330.1600</channelA>

  <energyA>   36.4000</energyA>

  <channelB> 5879.4102</channelB>

  <energyB>  662.0000</energyB>

</calibration>

<volatile>

  <intemp>42</intemp>

  <adctemp> 0.81</adctemp>

  <bias>0</bias>

  <cpwr>0</cpwr>

</volatile>

</nanoMCA-II>

Calibration data

Volatile data
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Appendix B: Setting BDC 
 

To set the BDC follow these steps: 

1) Use BDC = 1 to setup a measurement, all measurement parameters must be set 

2) Acquire a spectrum at 16384 channel soft size and adjust the gain so that there are 

well above the half of the full spectrum size (16384) (Fig B1). 

3) Mark an ROI that overlaps the middle of the spectrum (channel 8192). 

4) Place the cursor within the ROI and press the ROI-SCA trigger button of the Trace 

Viewer.  

20k

 

Figure B1. Example BDC that is not optimally adjusted. 
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5) Press/select the following buttons of the Trace Viewer: ADC, 0, RUN.  

6) Set Trace Viewer Vertical to 4k/div, place the trigger mark at the middle of the 

window, and adjust Horizontal so that the peak of the ADC signal is well visible.  

7) Adjust BDC so that the ADC peak amplitude is about 20k. This completes the 

adjustment. 

 

20k

 

 

Figure B2. Example optimally adjusted BDC. 

 


